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Disclaimer

The contents of this report reflect the view of the authors, who are responsible for the facts and
the accuracy of the data presented herein. The contents do not necessarily reflect the official views
or policies of the Texas Department of Transportation (TxDOT). This report does not constitute
a standard, a specification or a regulation.

NOT INTENDED FOR CONSTRUCTION, BIDDING, OR PERMIT PURPOSES
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1 Introduction

This document is the User’s Guide for the Travel Time Reliability program suite. This program
suite contains a set of programs written under the TxDOT grant 0-5453 stratagies for Improving
Travel Time Reliability. This document contains information on how to use the programs in the
Travel Time Reliability suite. For the rest of this document we shall refer to the Travel Time
Reliability suite as TTReliability.

A software file “TTReliability.rsc” is supplied in the accompanying CD. Chapter 2 of this User’s
Guide contains the instructions to install this software file. During the installation process, the
file will create an add-in which will appear as TTReliability (0-5453) menu on the menubar of
TransCAD. Under the TTReliability (0-5453) menu are the following submenus:

• Adjust O-D Matrix

• Adjust Link Capacity

• Set Variance Of O-D Travel Time

• Traffic Assignment With Fixed O-D

• Traffic Assignment With Departure Time Choice

• Plot VHT & VMT

• Plot Hotspots

• Plot Capacity Reliability Curve

Each submenu consists of a program which performs a customized procedure or gives instruc-
tions for the user to perform a procedure using the default functions provided by TransCAD. These
programs, when used in combinations, allow users to perform traffic assignment analyses with travel
time reliability consideration. Chapter 3 explains the different sequences of execution of these pro-
grams for users to carry out various traffic assignment analyses. Chapters 4 to 11 contain the
instructions on how to use each of these programs.

In the following chapters of this User’s Guide, words that appear in italic, for example TTRe-
liability (0-5453) inidicate the items that appear in the TransCAD program (usually seen on the
screen). These can be the names of menus, submenus, dialog boxes, buttons etc. Filenames, di-
rectories/paths are enclosed in double quotations. Single quotes are used to enclose the text and
numbers that shall be entered by the user.
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2 Installation

The supplied CD contains a file “TTReliability.rsc”. It has to be compiled and converted into a
TransCAD desktop application. It is recommended for the user to be familiar with compilation
and installation of the TransCAD add-in. Instructions for compilation and installation of add-ins
can be found in the Help menu in TransCAD, under GISDK Help → Quick Start → Lessons 5 and
6. Nevertheless the step by step instructions for compiling and installing the “TTReliability.rsc” is
given below.

Compilation of Resource file

1. Copy the file “TTReliability.rsc” from the CD to the desktop.

2. Start the TransCAD program.

3. Go to the Tools menu in TransCAD, select Add-Ins. A dialog box with the name Add-ins
will appear. Select the GIS Developer’s kit from the list in the dialog box and click the OK
button.

4. In the GISDK Toolbox, click the Compile to UI button (third button from the left) to display
the Compile dialog box.

5. Choose the “TTReliability.rsc” file which is stored on your desktop and click the Open button.

6. TransCAD displays a Save As dialog box. Type the filename ‘ttreliability’ and click Save
in the “TransCAD” folder. By the default installation settings of TransCAD, this folder
is “C:\Program Files\TransCAD\”. This procedure creates a user database file “ttreliabil-
ity.dbd” and six other files with the name “ttreliability” but with extensions “.1, .2, .3, .4,
.5, .6” respectively.

7. Close the GISDK toolbox.

Creation of Add-In

The above steps compile the resource file “TTReliability.rsc” into the 7 different files in the Tran-
sCAD’s user interface database. The following steps are necessary to convert these 7 files into the
TTReliability add-in.

1. Go to the Tools menu in TransCAD, select Add-Ins. A dialog box with the name Add-ins
will appear.

2. Click the Setup button to display the Setup Add-Ins dialog box.

3. Click the Add button to create a new add-in. This procedure creates an Untitled Add-in the
Add-ins list box. The Type: Macro in the Settings frame is also selected by default.
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4. Edit the Description text box in the Settings frame and enter ‘Travel Time Reliability’. This
updates the Untitled Add-in in the Add-ins list box to the name Travel Time Reliability.

5. Next, edit the Name textbox in the Settings frame and enter ‘TTReliability’.

6. In the Settings frame, click the Browse button and choose the UI Database file“ttreliability.dbd”
which you have created previously. If you follow the compilation instructions above, the file
should be in the folder “C:\Program Files\TransCAD\”. Select this file and click the Open
button.

7. In the Setup Add-ins dialog box, click the OK button to install the add-in and return to the
Add-Ins dialog box.

8. Highlight the Travel Time Reliability in the scroll list and click the OK button. TransCAD
now closes the Add-Ins dialog box and creates a menu TTReliability (0-5453) on the main
menu bar as shown in Fig. 1.

Loading the Add-In

When the user starts the TransCAD program, TTReliability (0-5453) menu will not appear on the
menu bar. The user has to execute the following steps in order to add the TTReliability (0-5453)
menu to the main menu bar.

1. Go to the Tools menu in TransCAD, select Add-Ins. A dialog box with the name Add-ins
will appear.

2. Highlight the Travel Time Reliability in the scroll list and click the OK button. TransCAD
now closes the Add-Ins dialog box and creates a menu TTReliability (0-5453) on the main
menu bar.

TTReliability as a Desktop Shortcut

It is possible to create a desktop shortcut such that each time when the TransCAD program is
activated, it automatically loads the TTReliability(0-5453) menu onto the main menu bar. The
following are the instructions to create a destop shortcut of TransCAD with the TTReliability(0-
5453) menu.

1. Make sure that the TransCAD is closed. If not select File→Exit to terminate the TransCAD
program.

2. Create a shortcut of TransCAD and place it on your desktop.

3. Right-click on the shortcut icon and choose Properties tab to display the Properties dialog
box.
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4. Click the General tab and replace the text in the edit box with ‘TransCAD with TTReliabil-
ity’.

5. Click the Shortcut tab and append the following text in the Target edit box:
-q -a TTReliability -ai TTReliability -n “TransCAD with TTReliability”
The edit box now looks like this
“C:\Program Files\TransCAD\tcw.exe” -q -a TTReliability -ai TTReliability -n “TransCAD
with TTReliability”

6. Click the OK button to close the Properties dialog box.

7. The shortcut is now ready for use. Double-clicking this new shortcut icon will start TransCAD
with the TTReliability(0-5453) menu in the main menu bar.

Figure 1: Travel Time Reliability Menu - After Installation.
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3 Recommended Use of Travel Time Reliability Program Suite

The TTReliability program suite consists of eight programs:

• Adjust O-D Matrix

• Adjust Link Capacity

• Set Variance of O-D Travel Time

• Traffic Assignment with Fixed O-D

• Traffic Assignment with Departure Time Choice

• Plot VMT & VHT

• Plot Hotspots

• Plot Capacity Reliability Curve

These programs, in combinations, are used to perform various traffic assignment analyses for
risk averse drivers in a stochastic network. Before presenting the recommended sequence on the
use of these programs, the functions of each of these programs are briefly described below:

The Adjust O-D Matrix program displays instructions for users to use the default functions
provided by TransCAD to multiply an original O-D matrix by a constant to form a new O-D
matrix.

The Adjust Link Capacity program changes the capacities of all the links in the TransCAD
Dataview table according to the link facility types and new capacities specified by the user.

The Set Variance of O-D Travel Time program computes the variance of route travel time
between all the O-D pairs in a network caused by incidents. The variances between all the O-D
pairs are stored in a matrix in the same format as the O-D matrix.

The Traffic Assignment with Fixed O-D displays instructions for users to use the default
functions provided by TransCAD to perform traffic assignment for risk averse drivers in a stochastic
network.

The Traffic Assignment with Departure Time Choice program automatically performs
traffic assignment for risk averse drivers in a stochastic network over several time intervals, each
with an O-D matrix. This program uses the travel times obtained from the traffic assignments to
adjust the O-D matrices to account for changes in users’ departure times. This program outputs a
set of new O-D matrices (one for each interval) and the traffic assignment results of the intervals.

The Plot VMT & VHT program plots two charts from the output files of the Traffic Assign-
ment with Departure Time Choice program: the total vehicle-miles traveled (VMT) in a network
over the time intervals and the total vehicle-hours traveled (VHT) in a network over the time
intervals.

The Plot Hotspots program plots the curves of Volume-Capacity (V-C) ratio versus time
interval for selected links in a network based on the output of the Traffic Assignment with Departure
Time Choice program.
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The Plot Capacity Reliability Curve computes and plots the capacity reliability curve of
a network when the networks traffic demand (original O-D matrix) is increased or decreased by a
series of multiplication factors.

Some of these eight programs, when use in the correct sequences, enable you to perform two
types of traffic assignment analyses:

• traffic assignment with a fixed O-D matrix

• traffic assignment with departure time choice

in a stochastic network with risk averse drivers. The sequences of use of these programs to perform
the two types of traffic assignment analyses are described in the following two sections.

Performing Traffic Assignment with A Fixed O-D Matrix

This refers to traffic assignment for risk averse drivers in a stochastic network. The analysis is to
be performed for the peak hour in the morning commute, or at other hour in the day when drivers
exhibit risk averse route choice behavior. This analysis uses only one O-D matrix to represent the
traffic demand during the peak hour. It assumes that the O-D matrix remains the same after traffic
assignment, i.e., drivers will not change the departure times.

1. Decide on the hour of the day in which traffic assignment is to be performed.

2. Construct the hourly O-D matrix. Very often, the O-D matrix that comes with the TransCAD
network database is a 24-hour O-D matrix in which the trips are in vehicles/day. Since the
analysis period is one hour, the O-D matrix must be in unit of vehicles/hour. Follow the
instructions in the Adjust O-D Matrix program to construct the hourly O-D matrix from the
original matrix.

3. Adjust the link capacity to hourly capacity. Very often, the link capacity in the Dataview
table in the TransCAD database is given in vehicles/day. Since the analysis period is one
hour, the capacity must be in vehicles/hour. Use the Adjust Link Capacity program to change
the link capacity in the Dataview table for each facility type.

4. Perform traffic assignment, with the hourly O-D matrix and hourly capacity as inputs, ac-
cording to the instructions given in the Traffic Assignment with Fixed O-D program. Use
the data in the traffic assignment output file (ASN LinkFlow.bin) to analyze the link and
network performances. Stop here if you do not wish to plot the capacity reliability curve.

5. Use the Plot Capacity Reliability Curve program to analyze the change in the networks ca-
pacity reliability when the overall traffic demand (O-D matrix) changes. If the O-D matrix
in the future years are available (through some lane use-transportation forecasting models),
you may use these new O-D matrices and repeat Steps 2 to 4. Alternatively, if the capacities
of certain links change in the future years (for example, due to the construction or expansion
of new facilities), you may repeat Steps 2 to 4 with the new link capacities. In other words,
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the change in capacity reliability may be analyzed with respect to the changes in O-D matrix
and/or link capacity.

Performing Traffic Assignment with Departure Time Choice

The idea of traffic assignment with departure time choice is to model the changes in drivers’
departure times due to traffic congestion along the routes. This requires more effort to organize
the input data and more steps in the modeling process.

To model the changes in drivers’ departure times, a time period (e.g., 6:00 a.m. to 9:00 a.m.)
that covers the morning peak needs to be defined. This time period is divided into several constant
time intervals. Drivers can change the departure time from one interval to the next. The time
intervals must be sufficiently short to reflect the drivers’ decision interval (e.g., to depart 5, 10 or
15 minutes earlier or later) but sufficiently large enough for most of the drivers to complete their
trips before the route travel time changes. A 15-minute interval is recommended as a compromise.

1. Decide the time period and duration of time intervals.

2. Construct the input O-D matrices. One input O-D matrix must be prepared to each time
interval. Each matrix consists of the trips made within the time interval, expressed in vehi-
cles/hour. You may use the Adjust O-D Matrix program to construct the hourly O-D matrix
from the original 24-hour matrix. One way of obtaining the input matrices is to multiply the
24-hour O-D matrix by the respective K-factors of the intervals and then convert the unit to
vehicles/hour.

3. Adjust the link capacity to hourly capacity. Since the unit of the O-D matrices is vehi-
cles/hour, the capacity must be converted to vehicles/hour. Use the Adjust Link Capacity
program to change the link capacity in the Dataview table for each facility type.

4. Use the Adjust Link Capacity program to perform traffic assignment and adjust the O-D
matrices for all the intervals. The output of the Traffic Assignment with Departure Time
Choice program is a set of new O-D matrices (one for each time interval) and a set of traffic
assignment files (one for each interval). The following two steps help to analyze the output
of this program using the data in these two sets of output files.

5. Use the Plot VMT & VHT program to visualize the change in total vehicle-miles traveled
(VMT) and total vehicle-hours traveled (VHT) in the network over the time intervals.

6. Use the Plot Hotspots to visualize the change in V-C ratio of selected links over the time
intervals.
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4 Adjust O-D Matrix

The Adjust O-D Matrix program activates a dialog box that shows the instructions to modify an
input Origin-Destination (O-D) matrix. This procedure may be used to convert an original O-D
matrix which has trips over a longer period (e.g., 24 hours) into a new O-D matrix which has trips
over a shorter period (say, one hour). The original matrix is multiplied by a constant (e.g., the
K-factor to obtain an output matrix). The constant should be determined off-line by the user prior
to using this program. Clicking the Adjust O-D matrix submenu pops up a dialog box which shows
the instructions as in Fig. 2. Click the Exit button to return to the TransCAD menu.

Figure 2: Adjust O-D Matrix – Instructions.
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5 Adjust Link Capacity

This program is for users to change the capacities of all the links in a network. It changes the link
capacities according to the link’s facility type (or functional class). It requires the user to input the
number of facility types and the capacity of each facility type in the network database in terms of
vehicles per lane.

This program may be used to convert a TransCAD network database which has 24-hour capacity
into hourly capacity. This program reads the network’s geographic file (*.dbd) and its attribute
table (*.bin). It replaces the link capacity values in columns (AB CAP, BA CAP, TOT CAP) in
the Dataview table with new values. The number of lanes in each direction of the links are taken
into account. That is, the new capacity values in columns (AB CAP, BA CAP, TOT CAP) are
the capacities of all the lanes combined. The screenshot in Fig. 3 shows the first dialog box when
the Adjust Link Capacity submenu is selected.

Figure 3: Adjust Link Capacity – Instructions.

Click the Next button to go to the next dialog box.
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Browse for the geographic file (*.dbd) as shown in Fig. 4.

Figure 4: Adjust Link Capacity – Select Geographic File.

Click the Next button to open the geographic file.
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Once the geographic file has been opened, the program will automatically detect and select the
link layer as the current layer as shown in Fig. 5.

Figure 5: Adjust Link Capacity – Selected Geographic File.

Click the Next button to go to the next dialog box.
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In the dialog box as shown in Fig. 6, enter the number of facility types (number of road classes)
in the network. This value will lead the program to create the same number of rows of entry as
shown in Fig. 7.

Figure 6: Adjust Link Capacity – Input Number of Facility Types.

It is important that you enter exactly the same number of facility types as in the database. For
example, if the database has 6 facility types denoted by numbers 1, 2, 3, 4, 7, 8. Enter ’6’ in the
provided text box. Click the Next button to continue to the next dialog box.
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For each facility type as shown in Fig. 7, double click the item to activate an Input Capacity
dialog box for the corresponding facility type. Enter the facility type number (road class) and the
new capacity (in vehicles per hour per lane) in the Input Capacity dialog box, followed by clicking
the OK button. Repeat this step for all the facility types.

Figure 7: Adjust Link Capacity – Input Capacity.
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Click the Run button to change the capacities in the Dataview table. If the program runs
successfully, the final dialog box appears as shown in Fig. 8 will appear.

Figure 8: Adjust Link Capacity – End of Program.

Click the Exit button to end the program and return to the TransCAD menu. It is strongly
recommended that you check the new capacity values in all the facility types in the Dataview table
in conjunction with the number of lanes in each link.
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6 Set Variance Of O-D Travel Time

This program computes the variance of route travel time for all O-D pairs (denoted in short as
variance OF O-D travel times) in a network. It assumes that the variance is caused by lane blocking
incidents which can only occur one at a time in the network.

The program reads an incident database (*.bin) file that contains the link ID of the incident
locations, number of lanes closed by the incidents and incident start times. For each of the incidents:
(1) user equilibrium traffic assignment is performed with reduced link capacity at the incident
location; followed by (2) calculation of O-D travel times. This program assumes that the incident
data is collected over several months at the same time period of every day (e.g., morning peak of
6 a.m. - 9 a.m.). The time period in the database (e.g., 6 a.m. - 9 a.m.) is divided into several
time intervals (e.g., 15 minutes). For each time interval, and for each O-D pair, the O-D travel
times due to the presence and absence of incidents in this time interval are then used to compute
the variance of O-D travel time in this time interval for this O-D pair.

To use this program, you must first run the programs Adjust O-D Matrix and Adjust Link
Capacity. Use the Adjust O-D Matrix program to create O-D matrices corresponding to different
time intervals.

This program requires one more input file: the incident database file in *.bin format. The
number of rows in this data file is the number of incidents. This data file must have 4 columns:

• date

• time (in seconds from 0000 hrs)

• link ID of the incident locations

• number of lanes closed by the incidents

It assumes that all the links in the database are one-way links. The incident occurred during the
entire time interval of interest (e.g., 15 minutes). An example of the incident database file is shown
in Fig. 9.
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Figure 9: Set Variance Of O-D Travel Time – Inicident Database File.

This program produces several output files in the matrix format (*.mtx) corresponding to
different time intervals within the time period. Each file contains the variances of travel times for
all the O-D pairs in the network in a time interval. These matrices are the necessary input files for
the Traffic Assignment with Departure Time Choice program.
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The instructions as shown in Fig. 10 will be displayed when Set Variance of Travel Time
submenu is selected.

Figure 10: Set Variance Of O-D Travel Time – Instructions.

Click Next button to continue to the next dialog box.
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The Path Options dialog box appears as shown in Fig. 11. Use the browse buttons to select the
geographic file and incident database file.

Figure 11: Set Variance Of O-D Travel Time – Path Options.

Click the Next button to open both files in TransCAD.
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More instructions will be displayed as shown in Fig. 12. It shows that the line layer has been
set as the current layer and warns the user not to change the current layer through out the entire
program.

Figure 12: Set Variance Of O-D Travel Time – Selected Geographic File.

Click the Next button to proceed to the next dialog box.
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Input the Dataview field names (column headings) of Capacity(E.g. AB CAP/BA CAP) and
Time (E.g. TIME) as shown in Fig. 13. Do not include ‘[’ and ‘]’ in the column names, but keep
the space in the column names, if any. If there are more than one columns associated with capacity
(for two-way links), use ‘/’ to separate them.

Figure 13: Set Variance Of O-D Travel Time – Input Capacity and Time Fields.

Click the Next button to continue to the next dialog box.
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The Path Options dialog box appears as shown in Fig. 14. In this step, you need to specify the
location of the folders to store the input and output files. Browse and select an existing folder, and
then enter the name of a new subfolder with which the program will create later for the input and
output files.

Figure 14: Set Variance Of O-D Travel Time – Matrix Paths.

Click the Next button to go to the next dialog box.
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This dialog box requires you to provide the properties of the input O-D matrices like number
of zones, time period, time intervals and the number of days over which the incident database was
collected. The Input Parameters dialog box for entering these information is shown in Fig. 15.

Figure 15: Set Variance Of O-D Travel Time – Properties of Input O-D Matrix Files.

After you have entered all the necessary information, click the Next button to continue to the
next dialog box.
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The next dialog box as shown in Fig. 16 displays the instructions on how to copy and name the
O-D matrix files. Follow the instructions as shown in the dialog box. You may copy and rename the
matrix files in the window enivronment without exiting the Set Variance of Travel Time program.
A folder view of copied input O-D matrices is shown in Fig. 17.

Figure 16: Set Variance Of O-D Travel Time – Copy O-D Matrix Files.

After you have finished copying and renaming the files, click the Next button in the dialog box
to continue to the next dialog box.
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Figure 17: Set Variance Of O-D Travel Time – Folder View of Input O-D Matrices Folder.
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The traffic assignment procedure within this program makes use of the ELD function to repre-
sent the risk averse route choice behavior of the drivers. Input the a1 value for the ELD function.
It is recommended that you keep the default value as shown in Fig. 18.

Figure 18: Set Variance Of O-D Travel Time – Default Value of a1.

Click the Run button to start running the program. Once the program has finished its cal-
culations, a dialog box as shown in Fig. 19 will appear. The accompanying instructions indicate
where the output matrices are saved. It is recommended that you check this new folder for the files
such as the screen shot shown in Fig. 20. Take note of this folder as the output files will need to
be copied to a specific folder when you run the Traffic Assignment with Deaparture Time Choice
program later.
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Figure 19: Set Variance Of O-D Travel Time – End of the Variance Program.

Click the Exit button to end this program and return to the TransCAD menu.
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Figure 20: Set Variance Of O-D Travel Time – Folder View of New Output O-D Matrices.
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7 Traffic Assignment With Fixed O-D

This program shows the instructions to perform user equilibrium traffic assignment for risk averse
drivers using the equivalent link disutility (ELD) function, with a fixed O-D matrix as shown in
Fig. 21. Traffic assignment using the BPR function can be performed with the standard TransCAD
Planning → Traffic Assignment menu (see Chapter 9 of Travel Demand Modeling with TransCAD
Version 4.8). User equilibrium traffic assignment with the ELD function (for example, with a1 =
1.4356) can be performed by changing the default value of α to a1α. For example, if α = 0.15, and
a1 = 1.4356; instead of typing α = 0.15 in the Alpha text box as shown in Fig. 22, enter ’0.2153’
here.

Figure 21: Traffic Assignment with Fixed O-D – Instructions.

Click the Exit button to return to the TransCAD menu.
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Figure 22: Traffic Assignment with Fixed O-D – Traffic Assignment with Modified α Value.

29



8 Traffic Assignment With Departure Time Choice

This program performs traffic assignment for risk averse drivers using the equivalent link disutility
(ELD) function and iteratively adjusts the O-D matrix to account for the change in user’s choices
of departure time intervals. Essentially this program divides a peak time period (e.g. 6 a.m. to
9 a.m.) into several consecutive time intervals (e.g. 15 minutes). For each time interval, traffic
assignment is performed for risk averse route choice behavior. The travel times obtained from the
traffic assignment is then used to adjust the drivers’ departure times, and hence the O-D matrices.
The new O-D matrices are then used to perform traffic assignment in the next iteration. The
program will run iteratively until the changes in the O-D matrices are negligible.

This program requires two sets of input files:

1. O-D matrices. The number of O-D matrices must be the same as the number of time intervals
in which you want to adjust the departure time choice. These matrices may be obtained from
the Adjust O-D Matrix program. The unit in each element of the O-D matrices must be
vehicles per hour.

2. Variance O-D travel time matrices. The number of travel time variance matrices must also
be the same as the time intervals. These matrices may be obtained from the Set Variance of
O-D Travel Time program.

This program produces two sets of output files:

1. New O-D matrices. One new O-D matrix will be generated for each time interval, after the
users have adjusted their departure times.

2. ASN LinkFlow.bin files. This is the output file of traffic assignment generated by TransCAD.
One file will be generated for each time interval.

When you run this program, you will be asked to input the name of a new subfolder for the
program to save all the input and output files. The above instructions will be displayed in a dialog
box as shown in Fig. 23 when this program is activated.
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Figure 23: Traffic Assignment with Departure Time Choice – Instructions.

Click the Next button to input the data.
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Use the Browse button to select a geographic file as shown in Fig. 24.

Figure 24: Traffic Assignment with Departure Time Choice – Select Geographic File.

Click the Next button to open the geographic file.
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The program will automatically select the link layer as the current layer as shown in Fig. 25.

Figure 25: Traffic Assignment with Departure Time Choice – Selected Geographic File.

Click the Next button to specify the necessary link attributes in the Dataview table for traffic
assignment.
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Type the column names of free flow travel time and capacity in the Dataview table of the
network as shown in Fig. 26. You may open the Dataview table in TransCAD to locate the correct
columns and their names.

Figure 26: Traffic Assignment with Departure Time Choice – Input Column Names.

Click the Next button to create a new subfolder for the input matrices.
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This program will create output files and save them in a new subfolder so that you can use them
later for analysis. Therefore you must tell this program the location and name of this subfolder
using the dialog box as shown in Fig. 27. Use the Browse button to select an existing folder. It
is recommended that you select the same folder as the geographic file. Next, type the name of the
new subfolder to be created.

Figure 27: Traffic Assignment with Departure Time Choice – Create Sub-Folder.

Click the Next button to create the new subfolder under this existing folder.
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The succeeding dialog box (Fig. 28) is for you to provide the properties of the input O-D
matrices. Fill the required fields as shown in Fig. 28. In the example shown, the user wants to
input 15 minute O-D matrices to the program in the time period from 6:00 a.m. to 9:00 a.m. So a
total of twelve 15-minute O-D matrices has to be provided to this program in the period ‘6:00 a.m.
to 9:00 a.m.’.

Figure 28: Traffic Assignment with Departure Time Choice – Properties of O-D Matrices.

Click the Next button to see further instructions.

36



The program has now created the new subfolder you specified in Fig. 27. Under this subfolder,
the program has further created two auxiliary folders named OLD ODMTX and COST. Copy all
the input O-D matrices into the OLD ODMTX auxiliary folder and rename them to OD 1.mtx,
OD 2.mtx ... etc. Copy the variance of O-D travel time matrices into the COST auxiliary folder
and rename them to var 1.mtx, var 2.mtx . . . etc. Remember that these folders were created within
the new subfolder from the previous step.

Figure 29: Traffic Assignment with Departure Time Choice – Copy Matrices.

After you have finished copying and renaming the files, click the Next button to continue to the
next dialog box.
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These folders may now look like the screenshots in Fig. 30 and Fig. 31. The O-D matrix files
and the variance of O-D travel time files should be renamed as per the instructions in the dialog
box.

Figure 30: Traffic Assignment with Departure Time Choice – Old O-D Matrices Folder.

Click the Next button in the dialog box to proceed to input the work-start time of the zones.
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Figure 31: Traffic Assignment with Departure Time Choice – COST Folder.
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The dialog box to input work-start time is as shown in Fig. 32. Input the default average work-
start time for the zones. Also, enter the number of zones which have different average work-start
times.

Figure 32: Traffic Assignment with Departure Time Choice – Default Work-Start Time.

Click the Next button to input the work-start time of zones not following the default work-start
time.
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A list box will appear in the dialog box as shown in Fig. 33. The list box has the same number
of entries as the number of zones you entered in the previous dialog box which have different
work-start times. Double click each entry in the list box to bring out a dialog box named Enter
Work-Start Time for Special Zones. Enter the ID of the zone and the special work-start time of
the zone, then click the OK button. Repeat this step for all the zones in the list box.

Figure 33: Traffic Assignment with Departure Time Choice – Special Work-Start Times.

The work-start times you have entered will overwrite the default work-start times. Click the
Next button to specify the value of risk averse coefficient.
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The default value of a1 is 1.4356 is shown in Fig. 34. You may change the a1 value if necessary.
To use the BPR function, set a1 = 1.0.

Figure 34: Traffic Assignment with Departure Time Choice – a1 Value.

The program now has all the necessary input data. Click the Run button to start the iterative
calculation. The program will run from a few minutes to a few hours, depending on the network size,
convergence parameters in the Frank-Worfe algorithm, and the rate of convergence of the output
O-D matrices. The program has internally set the default value of 100 iterations and convergence
criteria of 0.00001 in the Frank-Worfe algorithm, according to TxDOT practice.
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The dialog box in Fig. 35 will be displayed when the program has finished its calculations.

Figure 35: Traffic Assignment with Departure Time Choice – End of Program.

The program has created two more auxiliary folders: (1) NEW ODMTX and (2) ASSIGN-
MENT. At the end of the calculations, the program has generated a set of new O-D matrices with
names Cur OD1.mtx, Cur OD2.mtx . . . etc . The number of new O-D matrices is equal to the
number of time intervals. These new O-D matrices are saved in the new NEW ODMTX auxiliary
folder.

In addition, this program has created a set of traffic assignment files with name assign 1.bin,
assign 2.bin . . . etc. The number of these files is the same as the number of time intervals. These
traffic assignment files are saved in the new ASSIGNMENT auxiliary folder.

Take note of the locations (full paths) of these two auxiliary folders as you will need them in
the Plot VMT & VHT and Plot Hotspots programs.

Click the Exit button to end the program and return to the TransCAD menu.
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9 Plot VHT & VMT

This program plots the total vehicle-miles traveled (VMT) and total vehicle-hours traveled (VHT)
over the time intervals, from the output files of the Traffic Assignment with Departure Time Choice
program.

This Plot VHT & Plot VMT program should only be used after you have ran the Traffic
Assignment with Departure Time Choice program. This program requires all the output files of the
Traffic Assignment with Departure Time Choice program. The time intervals in the plots are the
same as the departure time intervals used in the Traffic Assignment with Departure Time Choice
program.

This program plots the following curves:

1. Total VMT in the network over time intervals

2. Total VHT in the network over time intervals.

This program produces two curves in two different dialog boxes and a text file that has the
values of the data points used to plot the curves.

The first dialog box of this program is as shown in Fig. 36.

Figure 36: Plot VMT & VHT – Instructions.
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Click the Next button to bring out the Path Options dialog box as shown in Fig. 37. Browse
for the folder which has the output files that were created from Traffic Assignment with Departure
Time Choice program.

Figure 37: Plot VMT & VHT – Select Project Folder.

Click the Plot button to begin plotting the curves. The final plots may look like the one as
shown in Fig. 38.
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The two charts are behind the Instructions dialog box as shown in Fig. 38. Move the dialog
box to see the charts. The two charts should look like Fig. 39 and Fig. 40. Chart 1 plots the total
VMT in the network over the departure time choice intervals. The total VMT is in vehicle-mile per
hour. This is because, in traffic assignment, the unit of O-D matrix and the unit of link capacity
are in vehicles per hour. Chart 2 plots the total VHT in the network over the departure time choice
intervals. The total VHT is in vehicle-hour per hour. This is also because, in traffic assignment,
the unit of O-D matrix and the unit of link capacity are in vehicles per hour.

Figure 38: Plot VMT & VHT - End of Program.

Click the Exit button to end this program and return to the TransCAD menu.
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Figure 39: Plot VMT & VHT - VHT Chart.

Figure 40: Plot VMT & VHT - VMT Chart.
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In addition, a text file that stores the data points used to plot the charts has been created, and
saved in the folder you selected in Fig. 37. The format of the text file is shown in Fig. 41. You may
open the text file using a standard text editor.

Figure 41: Plot VMT & VHT - Output Text File.
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10 Plot Hotspots

This program plots the Volume-Capacity (V-C) ratio versus time interval for a selected link in
a network. Here, Hotspots refer to important links in a network where congestion is likely to
occur. This program should only be used after you have run the Traffic Assignment with Departure
Time Choice program. This program requires all the output files of the Traffic Assignment with
Departure Time Choice program. The time intervals in the plot are the same as the departure time
choice intervals. This program produces a plot for each link (with one or two curves depending on
whether the link is a one-way or two-way link) and a text file that has the values of the data points
used to plot the curves.

Click the Hotspots submenu to display the Instructions dialog box as shown in Fig. 42.

Figure 42: Plot Hotspots – Instructions.

Click the Next button to display the next dialog box as shown in Fig. 43.
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Browse for the folder which stores the output files of the Traffic Assignment with Departure
Time Choice program.

Figure 43: Plot Hotspots – Select Folder.

Click the Next button to display the Path Options dialog box as shown in Fig. 44.

50



Select the geographic file.

Figure 44: Plot Hotspots – Select Geographic File.

Click the Next button to go to the next dialog box.
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After you have specified the geographic file and clicked the Next button, the next dialog box as
shown in Fig. 45 appears. You may then use the geographic file to locate the hotspot and identify
the link ID of the hotspot.

Figure 45: Plot Hotspots – Selected Geographic File.
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Once you have identified the link ID, return to the dialog box and click the Next button. Enter
the Link ID as shown in Fig. 46 followed by clicking the Plot button.

Figure 46: Plot Hotspots – Input Link ID.
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The program then searches the folder specified in Fig. 43 and retrieves the data, then plots the
V-C curve(s). The graphical output of this program is shown in Fig. 47. Move this pop-up window
to the right bottom corner of the screen to see the chart(s) that looks like the Fig. 48 and Fig. 49.
The X-axis of the charts refers to the volume over capacity ratios and the Y-axis of the charts
refers to the number of time intervals. If the hotspot is a one-way link, only one V-C curve will be
plotted in a chart. If the hotspot is a two-way link, there will be two V-C curves in two different
charts, one for each direction of travel. The directions can be identified by AB VOC and BA VOC
in the name of the charts.

The curves show the change in V-C ratios over several departure time choice intervals. This
program will automatically detects the number of departure time choice intervals from the files in
the data folder.

At any time you may click the Exit button to exit the program and return to the TransCAD
menu.

Figure 47: Plot Hotspots – End of Prgram.
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Figure 48: Plot Hotspots – AB VOC vs Time Intervals.

Figure 49: Plot Hotspots – BA VOC vs Time Intervals.
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This program will also produce a text file as shown in Fig. 50, which contains the data points
in the V-C curve(s). You may continue to plot another hotspot by clicking the Plot Another Link
button. Doing this will bring you back to the dialog box in Fig. 46. You may use the geographic
file to identify the link number before continuing with the plot.

Figure 50: Plot Hotspots – Output Text File.
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11 Plot Capacity Reliability Curve

This program plots the capacity reliability curves for a given transportation network. These curves
describe how the networks’ level of service changes when the overall traffic demand (O-D matrix)
changes. To simulate the change in traffic demand, we multiply all the trips in the O-D matrix by
the same factor µ.

The networks’ level of service can be characterized by the percentage of congested links. For
example, links for which the volume exceeds the capacity and therefore, the volume-to-capacity (V-
C) ratio is higher than 1. Another reasonable measure of congestion is the percentage of supplied
facilities (in lane-miles) in the network that are congested.

The current program plots the two curves that illustrate the dependence of the above two
measures on the factor µ:

1. % of links with V-C ratio ≥ 1 versus µ

2. % of lane-miles with V-C ratio ≥ 1 versus µ

This program reads two input files:

1. Geographic file of the network (*.dbd)

2. O-D matrix file (*.mtx)

This program performs traffic assignment (with a fixed matrix, for risk averse dirvers in a
stochastic network) for each µ value specified by the user. After the traffic assignment, the two
measures of level service computed. This procedure is repeated for all the µ values in order to
generate all the data necessary to plot the capacity reliability curves.
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The program produces two curves and a text file which contains the values of the data points
used to plot the curves. Click the Plot Capacity Reliability Curve submenu to display the Instruc-
tions dialog box as shown in Fig. 51.

Figure 51: Plot Capacity Reliability Curve – Instructions.

Click the Next button to display the Path Options dialog box as shown in Fig. 52.
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The Path Options dialog box appears as shown in Fig. 52. Use the Browse button to select the
geographic file.

Figure 52: Plot Capacity Reliability Curve – Path Options.
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After you have specified the geographic file and clicked the Next button, the next dialog box as
shown in Fig. 53 appears. It shows that the line layer has been set as the current layer and warns
you not to change the current layer throughout the entire program.

Figure 53: Plot Capacity Reliability Curve – Selected Geographic File.

Click the Next button to display the next dialog box as shown in Fig. 54.
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In the Curve Options frame, input the minimum µ value, maximum µ value and number of
intervals between the minimum µ and maximum µ values. For example, if you want to plot the
curves for µ = 0.8, 0.9, 1.0, 1.1, 1.2, enter ’0.8’ for Min u, ’1.2’ for Max u and ’4’ for No. of intervals
in the respective text boxes.

In the Path Options frame, browse for the O-D matrix file. In the Link Performance Function
Options frame, select the link performance function you want to use in traffic assignment. In
the Traffic Assignment Fields, specify the names of the columns in the Dataview table which
corresponds the link capacity and free flow travel time.

Figure 54: Plot Capacity Reliability Curve – Input Parameters.
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Click the Plot button to start running the program. When the program has finished calculating
the curve points, an Instructions dialog box will be displayed as shown in Fig. 55. The two charts
are behind the Instruction dialog box as shown in Fig. 55. Move the dialog box to see the charts.
Chart 1 plots the percentage of lane-miles in the network that have V-C ratios > one versus µ as
shown in Fig. 56. Chart 2 plots the percentage of links that have V-C ratios > one versus µ as
shown in Fig. 57.

Figure 55: Plot Capacity Reliability Curve – End of the Program.

Click the Exit button to return to the TransCAD menu.
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Figure 56: Plot Capacity Reliability Curve – Chart 1.

Figure 57: Plot Capacity Reliability Curve – Chart 2.
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A text file with the name “reliability.txt” as shown in Fig. 58 has been generated and stored in
the same folder as the geographic file which you have selected.

Figure 58: Plot Capacity Reliability Curve – Output Text File.
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